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Андрей Александрович Орлов
AutoCAD 2010

 
Введение

 
Книга, которую вы держите в руках, посвящена программе AutoCAD 2010 – это уже 23-я

версия данного пакета. За долгие годы развития продукт компании Autodesk трансформиро-
вался из простого инструмента, способного лишь заменить собой кульман, в программу, при-
годную не только для формирования двухмерных чертежей, но и для создания реалистичных
трехмерных моделей. Фактически на данный момент AutoCAD 2010 является самой мощной
системой автоматизированного проектирования (САПР), работающей на персональном ком-
пьютере.

Данный видеосамоучитель, ориентированный в основном на начинающих пользовате-
лей, послужит вам путеводителем в захватывающем мире AutoCAD. Книга снабжена большим
количеством практических примеров, а на компакт-диске находятся видеоуроки, поэтому если
вы обладаете хотя бы небольшими навыками работы на компьютере, то понять основные при-
емы работы с программой сможете довольно быстро. В этом вам помогут начальные главы.
Инструменты, предлагаемые AutoCAD 2010, настолько разнообразны, что умение их рацио-
нально использовать будет приходить постепенно, с выполнением все новых и новых упраж-
нений.

Значительная часть книги посвящена созданию трехмерных чертежей. Научившись
настраивать множество параметров, а также использовать разнообразные материалы и источ-
ники света, вы сможете довольно легко создавать трехмерные реалистичные модели. Воз-
можно, заключительные главы видеосамоучителя, как и описание новых возможностей про-
граммы, будут полезны опытным пользователям.



А.  А.  Орлов.  «AutoCAD 2010»

6

 
От издательства

 
Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты

dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о

наших книгах.

mailto:dgurski@minsk.piter.com
http://www.piter.com/
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Глава 1

Знакомство с AutoCAD 2010
 

• Запуск программы
• Интерфейс программы
• Установки файлов чертежей
• Работа со справочной системой AutoCAD
• Резюме

Программа AutoCAD уже многие годы является одним из наиболее мощных и широко
распространенных инструментов проектирования. С выходом каждой новой версии возмож-
ности приложения становятся все шире, элементы управления модернизируются, появляются
новые. Если вы новичок в области автоматизированного черчения и не обладаете опытом
работы с AutoCAD, то, прежде чем приступить к работе, вам необходимо ознакомиться с
интерфейсом программы, а также с основными принципами работы в ней. Из данной главы
вы узнаете, как запускать AutoCAD 2010, познакомитесь с ее интерфейсом, а также научитесь
пользоваться справочной системой приложения.
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Запуск программы

 
Как и любое приложение, разработанное для операционной системы Windows, про-

грамму AutoCAD можно запустить несколькими способами. Рассмотрим наиболее распростра-
ненные из них.

• Использование меню Пуск. Для запуска программы нужно выполнить команду Пуск
→ Все программы → Autodesk → AutoCAD 2010 → AutoCAD 2010 – English.

• Использование ярлыка программы на Рабочем столе. Для запуска приложения доста-
точно найти на Рабочем столе его ярлык и дважды щелкнуть на нем.

• Если вы хотите не просто запустить программу, а открыть определенный файл чертежа,
необходимо открыть Проводник или любой другой файловый менеджер, с его помощью найти
нужный вам файл и запустить его. В результате загрузится AutoCAD и откроется требуемый
файл, а если вы уже запустили программу ранее, то просто откроется нужный файл.

• По умолчанию программа AutoCAD не создает ярлык на панели быстрого доступа,
однако вы можете сделать это, перетащив туда ярлык с Рабочего стола или из меню Пуск
при нажатой клавише Ctrl. Запуск приложения с данной панели удобен тем, что для этого не
нужно открывать меню. Кроме того, панель быстрого доступа всегда отображается на экране,
в то время как Рабочий стол может быть закрыт запущенными приложениями.

Открыв AutoCAD любым удобным способом, вы увидите на экране окно, в котором
программа предлагает указать область деятельности, наиболее приближенную к вашей работе:
архитектура, гражданское строительство, производство и т. д. (рис. 1.1).

Рис. 1.1. Окно мастера настройки интерфейса

В зависимости от выбранного варианта автоматически настраивается интерфейс про-
граммы. В результате инструменты, которые, по мнению разработчиков AutoCAD, больше
всего подходят для заданного вида деятельности, будут под рукой.

Чтобы открыть окно AutoCAD с параметрами по умолчанию, щелкните на кнопке Skip
(Пропустить), а в следующем окне – на кнопке Start AutoCAD 2010 (Запустить AutoCAD
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2010). В будущем при необходимости вы сможете изменить тип интерфейса в настройках про-
граммы.

После старта программы откроется окно New Features Workshop (Семинар по новым
возможностям) (рис. 1.2).

Рис. 1.2. Окно New Features Workshop (Семинар по новым возможностям)

Если вы работали с предыдущими версиями AutoCAD, то можете ознакомиться с
новыми возможностями продукта в окне справки. Если вы ранее не сталкивались с этой про-
граммой, просто откажитесь от просмотра семинара. Чтобы данное окно не появлялось каж-
дый раз при запуске AutoCAD, установите переключатель в положение No, don't show me this
again (Больше не показывать). В дальнейшем при необходимости вы сможете открыть это окно
в любой момент.

Нажав кнопку OK, вы увидите рабочее окно программы AutoCAD 2010 (рис. 1.3). Воз-
можно, на первый взгляд оно покажется вам очень сложным и громоздким, однако на самом
деле интерфейс очень удобен и способен адаптироваться под конкретные задачи.
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Рис. 1.3. Рабочее окно AutoCAD 2010
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Интерфейс программы

 
Окно программы AutoCAD состоит из нескольких частей, каждая из которых выполняет

определенные функции: ввод команд, отображение необходимой при черчении информации и
т. д. Некоторые инструменты взаимодополняют и даже замещают друг друга.

Центральная область рабочего окна программы называется графическим экраном. В ней
выполняются все построения. На графическом экране указатель мыши приобретает вид пере-
крестья и способен выполнять функции, используемые в проектировании: привязку к объек-
там, задание координат и направления. При выходе за границы графического экрана указатель
приобретает привычный вид.

В верхней части окна находится лента с вкладками, на которых расположены кнопки
команд (см. рис. 1.3). Она заменила пункты меню, используемые в предыдущих версиях про-
граммы. Для пользователей, предпочитающих прежний вид окна, предусмотрена возможность
переключения в режим, называемый классическим.

Рассмотрим ленту с вкладками, предназначенными для рисования двухмерных объектов
(видоизмененная лента для создания трехмерных объектов описана в главе 9).

• Home (Основная) – здесь собраны основные средства, используемые при работе с чер-
тежами. Данная вкладка содержит следующие группы команд.

· Draw (Черчение) – позволяет создавать графические примитивы, наносить штриховку,
создавать области или полилинии из замкнутых элементов, различные маскирующие объекты
и др.

· Modify (Редактирование) – содержит инструменты для такого преобразования объек-
тов, как масштабирование, удлинение, поворот, выравнивание и др., а также для редактирова-
ния штриховки, сплайна и других объектов.

· Annotation (Аннотационные объекты) – содержит инструменты для создания текста и
таблиц, а также для нанесения размеров.

· Layers (Слои) – позволяет работать со слоями.
· Block (Блок) – содержит инструменты для работы с блоками.
· Properties (Свойства) – позволяет управлять свойствами объектов.
· Utilities (Утилиты) – содержит инструменты измерения, быстрого выделения и под-

счета.
· Clipboard (Буфер обмена) – дает возможность работать с буфером обмена (копировать,

вырезать, вставлять фрагменты и т. д.).
• Insert (Вставка) – содержит инструменты для работы с блоками и связями. На вкладке

присутствуют следующие группы команд.
· Reference (Связи) – предназначена для управления связями.
· Block (Блок) – служит для создания, вставки и редактирования блоков.
· Attributes (Атрибуты) – позволяет создавать и редактировать атрибуты данных, нахо-

дящихся в блоках.
· Import (Импорт) – используется для импорта файлов других форматов.
· Data (Данные) – содержит инструменты для работы с обновляемыми полями, объектами

OLE, гиперссылками и другими объектами.
· Linking & Extraction (Связывание и распаковка) – содержит команды для работы со

связями.
· Content (Содержимое) – позволяет открыть палитру DesignCenter (Центр управления),

с помощью которой удобно работать с проектом. Кроме того, в данной группе расположена
строка поиска, используя которую можно искать уже готовые элементы дизайна, находящиеся
на сайте http://seek.autodesk.com.

http://seek.autodesk.com/
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• Annotate (Аннотация) – здесь собраны инструменты для создания текстовых надписей
в документе. На этой вкладке расположены такие группы команд.

· Text (Текст) – содержит инструменты для работы с текстом (изменения стиля, размера
шрифта и др.).

· Dimensions (Размеры) – предназначена для проставления размеров.
· Leaders (Выноски) – позволяет создавать и редактировать выноски.
· Tables (Таблицы) – содержит инструменты для работы с таблицами.
· Markup (Выделение) – содержит инструменты для создания областей выделения.
· Annotation Scaling (Масштабирование аннотационных объектов) – используется для

изменения масштаба аннотационных объектов. Аннотационными в AutoCAD называют раз-
личные пояснительные объекты – размеры, выноски, текст и т. д.

• Parametric (Параметрические) – включает в себя инструменты для параметрического
черчения, позволяющие работать с геометрическими и размерными ограничениями. При
использовании таких ограничений заданные соотношения между объектами остаются, даже
если сами объекты изменяются. Данная вкладка содержит следующие группы команд.

· Geometric (Геометрические) – предназначена для работы с геометрическими ограни-
чениями.

· Dimensional (Размерные) – позволяет использовать размерные ограничения.
· Manage (Управление) – дает возможность управлять ограничениями (удалять, пере-

именовывать, задавать им числовые значения, формулы и т. д.).
• View (Отображение) – позволяет управлять отображением объектов на экране. Рас-

смотрим некоторые группы команд, которые присутствуют на этой вкладке.
· Navigate (Навигация) – включает в себя инструменты для навигации по документу:

прокрутку, увеличение и уменьшение масштаба и т. д.
· Views (Виды) – позволяет выбрать наиболее удобный в данный момент вид отображения

объекта. Пиктограммы наглядно показывают назначение каждой команды.
· Coordinates (Координаты) – дает возможность указать подходящую систему координат.
· Viewports (Видовые экраны) – позволяет создавать и редактировать плавающие видо-

вые экраны.
· Palettes (Палитры) – предоставляет быстрый доступ к различным палитрам, которые

дают возможность управлять свойствами объектов, связями с другими файлами чертежей и
пометками, добавленными к документу; выполнять различные вычисления, публиковать под-
шивки листов, групп листов или отдельных листов и т. д.

· Windows (Окна) – содержит команды, используемые при работе с несколькими откры-
тыми чертежами. С помощью этой группы вы можете размещать окна документов в рабочей
области программы, а также фиксировать их положение.

• Manage (Управление) – содержит инструменты для изменения различных настроек
программы, адаптации интерфейса приложения (рабочего пространства, панелей инструмен-
тов, меню и сочетаний клавиш) для решения конкретных задач. На этой вкладке также нахо-
дится группа команд для работы с макросами, создаваемыми на языке программирования
VBA.

• Output (Вывод) – здесь собраны группы команд для настройки параметров предвари-
тельного просмотра документа перед печатью, вывода его на печать, публикации в Интернете
и экспорта.

•  Express Tools (Дополнительные инструменты)  – содержит дополнительные инстру-
менты различных категорий, которые просты в использовании и охватывают широкий диа-
пазон функций программы AutoCAD, включая черчение, выделение и изменение объектов.
Однако следует учитывать, что эти инструменты являются дополнительными и компания
Autodesk не гарантирует их корректной работы.
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При выборе определенных объектов на ленте могут появляться дополнительные вкладки
для работы с ними. Например, если вы вставите в документ таблицу, на ленте появится вкладка
Text Editor (Редактор текста) с инструментами для редактирования вводимого в таблицу тек-
ста.

По умолчанию на ленте расположены все основные вкладки, а на них, в свою очередь,
все группы команд. Чтобы убрать вкладку с ленты, щелкните на ленте правой кнопкой мыши
и в подменю Tabs (Вкладки) снимите флажок возле названия вкладки, которую планируете
удалить с ленты. Если вы хотите убрать с вкладки какую-либо группу команд, щелкните правой
кнопкой мыши на вкладке и в подменю Panels (Группы) снимите флажок рядом с названием
группы, которую необходимо скрыть. Аналогично действуйте, если хотите добавить вкладку
или группу на ленту, однако в данном случае флажки придется устанавливать рядом с нужным
пунктом.

Любую вкладку можно извлечь с ленты, чтобы она превратилась в отдельную панель
(рис. 1.4). Такая панель будет отображаться, даже если вы выберете другую вкладку, до тех
пор пока вы не нажмете на этой панели кнопку Return Panels to Ribbon (Вернуть группы на
ленту).

Рис. 1.4. Извлеченные с ленты вкладки

Чтобы скрыть ленту, нужно щелкнуть на кнопке с направленным вниз треугольником

которая находится справа от названий вкладок ленты. При первом щелчке лента свер-
нется до названий вкладок и групп инструментов, при втором – полностью исчезнет с экрана.
Чтобы снова отобразить ленту, следует опять нажать кнопку с треугольником.

Над лентой расположено меню приложения (кнопка с буквой «А»

). В нем вы найдете пункты, которые заменяли ленту с вкладками в предыдущих версиях
AutoCAD, а также некоторые другие элементы.

Рядом с кнопкой вызова меню приложения находится панель быстрого доступа. По
умолчанию на ней располагаются кнопки часто используемых команд: New (Новый), Open
(Открыть), Save (Сохранить), Undo (Отмена), Redo (Восстановление) и Plot (Печать).
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В новой версии программы панель быстрого доступа была дополнена новыми возмож-
ностями, которые позволяют удалять инструменты с панели, добавлять разделители, а также
отображать панель быстрого доступа над или под лентой.

Примечание
Вы можете самостоятельно добавить на панель быстрого

доступа необходимые элементы. Для этого щелкните на панели
правой кнопкой мыши и выберите пункт Customize Quick Access
Toolbar (Настройка панели быстрого доступа). Откроется окно
Customize User Interface (Настройка интерфейса пользователя), в
основной части которого по умолчанию расположен полный список
команд AutoCAD 2010. Чтобы быстрее найти нужную команду,
можете выбрать в раскрывающемся списке, расположенном вверху,
необходимую категорию. Чтобы добавить команду на панель,
щелкните на нужной строке кнопкой мыши и, не отпуская ее,
перетащите на панель быстрого доступа. Затем в окне Customize User
Interface (Настройка интерфейса пользователя) нажмите кнопку OK.

В левой нижней части окна программы отображаются вкладки Model (Модель), Layout1
(Лист 1) и Layout2 (Лист 2) (рис.  1.5). По умолчанию активной является вкладка Model
(Модель), которая означает, что на экране отображено двух– или трехмерное пространство
модели. При щелчке на какой-либо из вкладок Layout (Лист) (их количество может быть
любым) вы перейдете к пространству листа, о работе с которым будет рассказано в главе 8.
Слева от вкладок расположены кнопки перехода между ними.

Рис. 1.5. Вкладки переключения между пространствами листов и модели

В левой нижней части графической области окна программы отображается указатель
пользовательской системы координат (ПСК) (см. рис.  1.5) По умолчанию в программе
AutoCAD используется МСК — мировая система координат (World Coordinate System, WCS).
Ее указатель расположен в точке с координатами (0; 0; 0).
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Справа и снизу от графической области могут находиться полосы прокрутки, предна-
значенные для перемещения по чертежу. По умолчанию полосы прокрутки не отображаются,
поэтому при первом запуске программы вы их не увидите.

Совет
Для отображения полос прокрутки на экране перейдите на ленте

на вкладку View (Отображение) и в разделе Windows (Окна) щелкните
на кнопке

Будет вызвано окно Options (Параметры), на вкладке Display
(Экран) которого необходимо установить флажок Display scroll bars
in drawing window (Отображение полос прокрутки в окне чертежа)
(рис. 1.6).

Рис. 1.6. Вкладка Display (Экран) диалогового окна Options (Параметры)

В нижней части окна программы расположена строка состояния с набором кнопок для
управления отображением чертежа. Их мы рассмотрим далее, в соответствующем подразделе.

Программа AutoCAD позволяет пользователю самостоятельно определить цвет различ-
ных элементов рабочего окна. Для этого выполните следующие действия.

1.  Щелкните на кнопке меню с буквой «А» в  левом верхнем углу окна AutoCAD.
Появится меню для выбора команд управления программой.

2. В правом нижнем углу данного меню щелкните на кнопке Options (Параметры).
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3. В открывшемся диалоговом окне перейдите на вкладку Display (Экран) (см. рис. 1.6).
4. В области Window Elements (Элементы окна) щелкните на кнопке Colors (Цвета).
5. В появившемся окне Drawing Window Colors (Цвета окна чертежа) в списке Context

(Контекст) выберите разновидность окна программы, в списке Inteface element (Элемент
интерфейса) – элемент, а в раскрывающемся списке Color (Цвет) – нужный вам цвет.

Так, например, чтобы изменить фон пространства модели на белый, необходимо в списке
Context (Контекст) выбрать пункт 2D model space (Пространство двухмерной модели), в
списке Inteface element (Элемент интерфейса) – Uniform background (Однородный фон), а в
списке Color (Цвет) – White (Белый). При этом в поле Preview (Предварительный просмотр)
цвет фона сменится на белый (рис. 1.7).

Рис. 1.7. Изменение фона пространства модели

6. Нажмите кнопку Apply & Close (Применить и закрыть) для сохранения изменений и
выхода из диалогового окна.

Чтобы перейти к классическому виду рабочего окна программы, щелкните на кнопке
Workspace Switching (Переключение рабочего пространства), которая находится в нижней
части окна программы (на данной кнопке написано название текущего рабочего пространства,
например Initial Setup Workspace (Начальное установочное рабочее пространство)), и выбе-
рите в появившемся списке строку AutoCAD Classic (Классический AutoCAD). Окно про-
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граммы отобразится в классическом виде, более привычном для пользователей прежних вер-
сий (рис. 1.8).

Рис. 1.8. Классический вид окна программы AutoCAD

Познакомимся с ним подробнее. Строка меню включает в себя множество пунктов для
вызова различных команд и открытия диалоговых окон.

• File (Файл). Здесь находятся команды обработки файлов: создания, сохранения, вос-
становления. Кроме того, это меню содержит команды, используемые для печати документов.

• Edit (Правка). Пункты данного меню позволяют выполнять стандартные для Windows
операции работы с буфером обмена (вырезать, скопировать, вставить), а также команды спе-
циальной вставки, удаления, выделения и поиска.

•  View (Вид). С помощью команд данного меню вы можете управлять отображением
объектов на экране. Здесь расположены такие подменю, как Zoom (Масштабирование), Pan
(Панорамирование) и др. В этом же меню находятся команды регенерации чертежей. Кроме
того, меню View (Вид) содержит команду Toolbars (Панели инструментов), при выборе кото-
рой на экране отображается диалоговое окно Customize User Interface (Настройка интер-
фейса пользователя). С помощью данного окна вы сможете создавать собственные меню,
панели инструментов, назначать сочетания клавиш для быстрого вызова команд и окон, а также
редактировать имеющиеся. Более подробно об этом диалоговом окне будет рассказано ниже.

• Insert (Вставка). Команды этого меню позволяют вставлять в поле чертежа блоки и
объекты, созданные ранее в сторонних приложениях, а также импортировать в AutoCAD раз-
личные файлы.

• Format (Формат). Данное меню предназначено для вызова диалоговых окон, помога-
ющих определить множество параметров черчения. Последняя команда – Rename (Переиме-
новать) – служит для переименования различных объектов программы, таких как слои, мате-
риалы, блоки и др.
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• Tools (Сервис). Здесь вы можете изменять различные настройки программы, вызывать
на экран вспомогательные окна, а также загружать внешние приложения и управлять ими. В
этом же меню находится группа команд для работы с макросами, создаваемыми на языке про-
граммирования VBA.

Подменю Workspaces (Рабочие пространства) предоставляет доступ к рабочим про-
странствам программы. Оно служит для переключения между пространствами, а также для их
настройки и сохранения.

Палитры программы сгруппированы в отдельное подменю – Palettes (Палитры). Рассмот-
рим его содержимое.

· Ribbon (Лента) – включает отображение ленты с инструментами.
· Properties (Свойства) – открывает палитру, позволяющую управлять свойствами объ-

ектов.
· Layer (Слой) – вызывает палитру, содержащую команды для работы со слоями.
· Tool Palettes (Инструментальные палитры) – открывает палитру, содержащую различ-

ные инструменты, такие как блоки, образцы штриховок и т. д., в одном окне для упрощения
доступа к ним.

· QuickCalc (Быстрый подсчет) – вызывает палитру, позволяющую выполнить различные
вычисления (эту палитру можно также вызвать сочетанием клавиш Ctrl+8).

· External References (Внешние связи) – открывает палитру, которая дает возможность
управлять связями с другими файлами чертежей.

· Sheet Set Manager (Менеджер подшивок) – вызывает палитру, служащую для публи-
кации подшивок листов, групп листов или отдельных листов.

· Markup Set Manager (Менеджер пометок) – открывает палитру, которая позволяет
управлять пометками, добавленными к документу.

· DesignCenter (Центр управления)  – вызывает палитру, с помощью которой можно
управлять такими объектами чертежей, как блоки, внешние ссылки или образцы штриховки.

Подменю Palettes (Палитры) также позволяет вызывать различные палитры для работы
с освещением, материалами и визуализацией объектов. Их применение будет рассмотрено в
главах, рассказывающих о работе с трехмерными телами. Последняя палитра – dbConnect
(Связь с базами данных) – предназначена для работы с базами данных.

Далее в меню Tools (Сервис) находятся команды: Spelling (Правописание), которая поз-
воляет проверить орфографию в выбранном пользователем тексте, Quick Select (Быстрый
выбор), служащая для быстрого создания групп объектов, и Draw Order (Порядок следова-
ния), предоставляющая возможность переносить объекты на заданный план.

Подменю New UCS (Новая ПСК) содержит команды для создания новых ПСК (пользо-
вательских систем координат) с использованием различных методов, а также для редактиро-
вания имеющихся систем. Команда Named UCS (Именованные ПСК) открывает диалоговое
окно, отображающее сохраненные пользовательские системы координат.

С помощью пункта Drafting Settings (Режимы рисования) можно устанавливать необ-
ходимые настройки режимов рисования, а пункт Options (Параметры) (как говорилось ранее)
вызывает одноименное диалоговое окно, предназначенное для настройки параметров про-
граммы.

• Draw (Черчение). Команды этого меню предназначены для создания примитивных
двух– и трехмерных объектов.

· Подменю Modeling (Моделирование) используется для создания трехмерных объектов.
· Пункт Hatch (Штриховка) позволяет наносить штриховку в выбранных областях.
· Команда Boundary (Контур) служит для создания области или полилинии из замкнутых

объектов.
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· С помощью пункта Wipeout (Маскировка) можно создавать различные маскирующие
объекты.

· Подменю Text (Текст) предназначено для создания одно– или многострочного текста.
• Dimension (Размер). С помощью команд данного меню можно создавать размеры и

выноски различных типов, таких как Linear (Линейный), Aligned (Параллельный), Ordinate
(Ординатный). Здесь же расположены команды редактирования размерных надписей. Команда
Multileader (Мультивыноска) служит для создания мультивыносок (которые заменили собой
используемые в более ранних версиях программы выноски). Более подробно об этом мы пого-
ворим в главе 5, посвященной нанесению размеров.

• Modify (Редактирование). С помощью этого меню можно выполнять такие преобразо-
вания объектов, как масштабирование, удлинение, поворот и др.

Кроме того, здесь находятся команды редактирования таких объектов, как штриховка,
сплайн, текст и др., а также команды различных трехмерных операций и редактирования трех-
мерных тел.

Подменю Annotative Object Scale (Масштаб аннотационных объектов) позволяет добав-
лять и удалять значения масштаба аннотационных объектов.

• Parametric (Параметрические). Данное меню содержит команды для работы с геомет-
рическими и размерными ограничениями.

•  Window (Окно). Это меню включает в себя команды, используемые при работе с
несколькими открытыми чертежами, и служит для поддержки многодокументного режима
работы.

•  Help (Справка). В данном меню находятся разделы справки, содержащие полную
информацию, необходимую для работы в AutoCAD. Справочные материалы отображаются в
отдельном окне и не мешают работе с программой. Более подробно о справочной системе будет
рассказано далее.

• Express (Дополнительные средства). Это меню содержит дополнительные команды раз-
личных категорий и обладает собственной системой справки (пункт Help (Справка)), а также
сборником ответов на наиболее часто задаваемые вопросы (пункт Express Tools FAQ (Наи-
более часто задаваемые вопросы по Express Tools)).

 
Панели инструментов

 
Панели инструментов являются графическим интерфейсом команд программы

AutoCAD, то есть выполняют соответствующие им функции. О назначении кнопки вы можете
узнать, подведя к ней указатель мыши. При этом появится всплывающая подсказка с кратким
описанием кнопки. Если для команды назначено сочетание клавиш, оно также будет показано
во всплывающей подсказке. На рис. 1.9 представлена панель инструментов Standard (Стан-
дартная) с указателем мыши, подведенным к кнопке Save (Сохранить).
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Рис. 1.9. Подсказки панели инструментов

Многие кнопки на панелях инструментов дублируют команды на ленте или в меню (если
вы работаете с классическим интерфейсом программы). Вы можете выбрать более удобный
для себя способ вызова команды.

В правом нижнем углу некоторых кнопок имеется маленькая черная стрелка. Если какое-
то время удерживать на ней нажатой левую кнопку мыши, на экране появится меню с допол-
нительными элементами. На рис. 1.10 показано меню Zoom Window (Масштабирование окна)
панели инструментов Standard (Стандартная).

Рис. 1.10. Меню дополнительных инструментов Zoom Window (Масштабирование окна)

Панели инструментов могут быть закрепленными (в таком состоянии они отображаются
по умолчанию) и плавающими. Название плавающей панели инструментов можно увидеть
в подсказке, появляющейся при наведении указателя мыши на панель. Для закрытия плава-
ющей панели инструментов предназначена кнопка с крестиком, расположенная в ее правой
части. Кнопки плавающей панели инструментов могут располагаться как в один ряд, так и в
несколько. Чтобы сделать панель плавающей, достаточно перетащить ее с помощью мыши на



А.  А.  Орлов.  «AutoCAD 2010»

21

некоторое расстояние от края графического экрана. На рис. 1.11 показана плавающая панель
инструментов Standard (Стандартная) с различным расположением кнопок.

Рис. 1.11. Различные состояния панели инструментов Standard (Стандартная)

Примечание
Если вы не хотите, чтобы панель инструментов «приклеивалась»

к краю графической области, при перемещении панели удерживайте
нажатой клавишу Ctrl.

Всего в AutoCAD 2010 имеется 44 панели инструментов. Чтобы отобразить или скрыть
какую-либо панель инструментов, щелкните на любой из них правой кнопкой мыши. На экране
появится меню, содержащее список доступных панелей (рис. 1.12).
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Рис. 1.12. Меню отображения/ скрытия панелей инструментов

Для отображения/скрытия любой панели выберите ее в меню. В нижней части меню рас-
положено подменю Lock Location (Место фиксации), с помощью которого вы можете блокиро-
вать положение панелей инструментов и палитр. Например, чтобы отобразить панель инстру-
ментов View (Вид) и блокировать ее, сделайте следующее.

1. Щелкните правой кнопкой мыши на любой панели инструментов и выберите пункт
View (Вид).

2. С помощью мыши перетащите панель инструментов, как показано на рис. 1.13.

Рис. 1.13. Перетаскивание панели инструментов

3. Щелкните правой кнопкой мыши на панели, в открывшемся меню выполните команду
закрепления плавающих панелей инструментов: Lock Location → Floating Toolbars/Panels
(Место фиксации → Плавающие панели ин струментов/группы).

Панель будет блокирована, и вы не сможете перемещать ее по рабочему окну. Для отмены
блокирования снова выполните эту же команду.

По умолчанию в рабочей области программы AutoCAD 2010 классического вида отоб-
ражены восемь наиболее используемых панелей инструментов, присоединенных к верхней,
левой и правой сторонам графической области программы. Остановимся на двух наиболее
часто используемых панелях инструментов.

•  Standard (Стандартная) (см. рис.  1.11)  – содержит кнопки, предназначенные для
вызова базовых команд, таких как создание, открытие, сохранение файла, просмотр проекта
перед печатью и вывод его на печать, операции с буфером обмена, отмена и возврат действий.
Кроме того, здесь расположены команды вызова палитр программы.

•  Workspaces (Рабочие пространства) (рис.  1.14)  – служит для переключения между
рабочими пространствами программы AutoCAD 2010: 2D Drafting & Annotation (Двухмер-
ное черчение и аннотирование), 3D Modeling (Трехмерное моделирование), AutoCAD Classic



А.  А.  Орлов.  «AutoCAD 2010»

24

(Классический AutoCAD) и Initial Setup Workspace (Начальное установочное рабочее про-
странство).

Рис. 1.14. Панель инструментов Workspaces (Рабочие пространства)

Остальные панели мы рассмотрим по мере описания работы с программой. Сейчас же
обратимся к основному средству работы с инструментами AutoCAD, а именно к инструмен-
тальной палитре, которая занимает правую часть рабочего окна программы.

 
Инструментальная палитра

 
Чтобы вызвать инструментальную палитру, выполните команду ленты View → Palettes →

Tool Palettes (Вид → Палитры → Инструментальные палитры). На инструментальной палитре
содержатся кнопки вызова инструментов, сгруппированные по их функциональному назначе-
нию на множестве вкладок (рис. 1.15).
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Рис. 1.15. Инструментальная палитра

Щелчок кнопкой мыши на значке открывает вкладку, содержащую набор кнопок для
выбора инструментов. Рассмотрим вкладки, отображаемые на инструментальной палитре по
умолчанию.

• Draw (Черчение). Кнопки в верхней части вкладки позволяют создавать различные
примитивы: Line (Отрезок), Construction Line (Прямая), Polyline (Полилиния), Polygon
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(Многоугольник) и т. д. Кнопки в нижней ее части служат для ввода более сложных объектов:
блоков, рисунков и др.

• Leaders (Выноски). Содержит набор кнопок, позволяющих создавать выноски.
• Command Tool Samples (Образцы командных инструментов). Включает в себя инстру-

менты для управления вводом команд.
• Tables (Таблицы). Здесь находятся инструменты для создания таблиц разных типов –

расписаний, легенд чертежей.
• Hatches and Fills (Штриховки и заливки). Содержит инструменты, позволяющие закра-

шивать поверхность чертежа, создавая узоры, заливки и градиенты. На вкладке содержится
множество доступных образцов узоров и заливок.

• Structural (Конструктивные). Здесь находятся инструменты для черчения стандартных
конструкций, например балок различных сечений.

• Civil (Гражданские). На вкладке собраны образцы различных знаков, применяемых для
привлечения внимания: запреты, оповещения и обозначения.

• Electrical (Электрические). Содержит обозначения, применяемые при рисовании элек-
тротехнического оборудования: наборы выключателей, сигнальных ламп и др.

• Mechanical (Механические). Здесь собраны инструменты для рисования механических
устройств: болтов, гаек, подшипников и т. д.

• Architectural (Архитектурные). Содержит инструменты для рисования дверей, окон и
прочих конструкций, используемых в строительстве.

• Annotation (Аннотационные объекты). Здесь собраны различные пояснительные обо-
значения, используемые на чертежах: стрелки, указания и примечания.

• Constraints (Ограничения). На этой вкладке представлены инструменты для работы с
геометрическими и размерными ограничениями.

• Modeling (Моделирование). Содержит сложные элементы, используемые при черчении
геометрических объектов: спирали, цилиндры, оси координат и т. д.

Как и все элементы пользовательского интерфейса программы AutoCAD, инструмен-
тальную палитру можно настроить в соответствии с вашими нуждами. Чтобы указать, какие
вкладки должны отображаться, щелкните правой кнопкой мыши на свободной части палитры,
чтобы вызвать контекстное меню. При выполнении команды Customize Palettes (Настройка
палитр) появляется диалоговое окно Customize (Настройка), в котором можно сконфигури-
ровать инструментальную палитру, добавить на нее новые вкладки и содержащиеся на них
инструменты.

 
Командная строка

 
Командная строка (рис. 1.16) расположена ниже графической области программы и поз-

воляет вводить команды с клавиатуры. В ранних версиях AutoCAD она была основным инстру-
ментом диалога пользователя и программы, однако с выходом новых релизов значение данного
элемента все больше снижается. Существенную роль в этом сыграло появление в AutoCAD
2006 динамического ввода, позволяющего вводить команды в области рисования, рядом с гра-
фическим курсором. Тем не менее командная строка выполняет определенные функции и все
еще остается достаточно важным элементом интерфейса. При работе вы периодически будете
ее использовать.

Рис. 1.16. Командная строка
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Независимо от способа ввода команда отображается в командной строке. Кроме того,
здесь присутствуют все параметры команды, а также подсказки. После ввода команды в
командной строке появится запрос на действие с доступными параметрами команды. Вы
можете задать параметры, запустить выполнение команды или прервать его, нажав клавишу
Esc.

Командная строка хранит историю введенных команд. Однако, поскольку область команд
занимает две строки, просмотр истории затруднителен. Вы можете увеличить размер команд-
ной строки, но это уменьшит графическую область, что очень неудобно. Для решения дан-
ной проблемы в программе AutoCAD предусмотрено отображение области команд в отдель-
ном окне. Если вам нужно просмотреть историю команд, нажмите клавишу F2, и на экране
появится окно AutoCAD Text Window (Текстовое окно AutoCAD) с необходимой информа-
цией (рис. 1.17). Чтобы убрать его, нажмите еще раз клавишу F2.

Рис. 1.17. Диалоговое окно AutoCAD Text Window (Текстовое окно AutoCAD)
 

Строка состояния
 

Как уже говорилось выше, в нижней части окна программы AutoCAD расположена
строка состояния (рис. 1.18).

Рис. 1.18. Строка состояния

Она содержит текущие координаты указателя мыши, а также кнопки включения/выклю-
чения режимов черчения. Кратко рассмотрим назначение кнопок.
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Snap Mode (Режим привязки) – включает/отключает режим шаговой привязки, то есть
привязки к точкам сетки с определенным шагом. Эту кнопку дублирует клавиша F9 на кла-
виатуре.

Grid Display (Отображение сетки) – включает/отключает отображение на экране сетки.
Щелчок на этой кнопке равнозначен нажатию клавиши F7.

Ortho Mode (Ортогональный режим) – включает/отключает ортогональный режим. При
включенном режиме перемещение указателя мыши ограничено горизонтальным и вертикаль-
ным направлениями. Эту кнопку дублирует клавиша F8.

Polar Tracking (Полярное отслеживание)  – включает/выключает режим полярного
отслеживания. Полярное отслеживание ограничивает перемещение указателя направлением
под заданным углом, облегчая выбор точек, лежащих на воображаемых линиях под одним из
заданных полярных углов. Щелчок на этой кнопке соответствует нажатию клавиши F10.

Object Snap (Объектная привязка) – позволяет выбирать различные точки объектов при
работе с ними, облегчая позиционирование графического курсора. Эту кнопку дублирует кла-
виша F3.

Object Snap Tracking (Объектное отслеживание) – включает/выключает режим объект-
ного отслеживания, который помогает вычерчивать объекты под определенными углами или в
определенных соотношениях с другими объектами. При включенных режимах автоотслежива-
ния специальные временные линии помогают выполнять точные построения. Щелчок на этой
кнопке равнозначен нажатию клавиши F11.

Allow/Disallow Dynamic UCS (Включить/выключить динамическую систему коорди-
нат) – включает/отключает режим динамической системы координат, которая предназначена
для работы с трехмерными объектами и позволяет временно выровнять плоскость XY по
какой-либо имеющейся плоскости.

Dynamic Input (Динамический ввод)  – включает/отключает режим динамического
ввода, который позволяет вводить команды и выбирать их параметры в области курсора, без
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использования командной строки. Если динамический ввод включен, сведения, отображаемые
в подсказках рядом с указателем мыши, динамически обновляются по мере его перемещения.
Когда команда активна, подсказки обеспечивают место для ввода, осуществляемого пользова-
телем.

Show/Hide Lineweight (Показать/скрыть толщину линий) – включает/выключает режим
отображения линий в соответствии с их толщиной.

Quick Properties (Краткие свойства)  – включает/выключает отображение панели со
свойствами выбранного объекта.

Model or Paper space (Пространство модели или бумаги) – позволяет переключаться
между пространствами модели и листа.

Quick View Layouts (Быстрый просмотр листов) – отображает сразу все листы чертежа
в отдельных окнах небольшого размера.

Quick View Drawings (Быстрый просмотр чертежей) включает/выключает просмотр чер-
тежей.

Pan (Панорамирование) – панорамирование рисунка.

Zoom (Масштабирование) плавное изменение масштаба рисунка.

SteeringWheels (Управление колесиком)  – включает инструмент Wheel (Колесико)
(рис. 1.19).
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Рис. 1.19. Инструмент Wheel (Колесико)

ShowMotion (Показать движение) – вызывает набор инструментов Motion (Движение).

Annotation Scale (Масштаб аннотационных объектов) меню, вызываемое нажатием этой
кнопки, позволяет установить текущее значение масштаба аннотаций. Любые аннотационные
объекты, добавленные на чертеж, будут отображаться в масштабе, соответствующем указан-
ному значению.

Annotation Visibility (Отображение аннотации) – изменяет значение системной пере-
менной ANNOALLVISIBLE. Когда ее значение равно 1, на экране отображаются все анно-
тационные объекты. Если переменной присвоить значение 0, будут видны лишь те объекты,
которые поддерживаются текущим значением аннотационного масштаба.

Automatically add scales to annotative objects when the annotation scale changes (Авто-
матически обновлять аннотационные объекты при изменении масштаба)  – регулирует зна-
чение системной переменной ANNOAUTOSCALE и отвечает за обновление аннотационных
объектов при изменении аннотационного масштаба.

Workspace Switching (Изменение рабочей области) – вызывает меню для выбора режима
отображения рабочей области.
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кнопка для блокирования положения панелей инструментов и окон. Пример использо-
вания данной функции был приведен выше.

Performance Tuner (Настройщик производительности) – тестирует вашу видеокарту и
выдает результаты в отдельном окне.

Application Status Bar Menu (Меню содержимого строки состояния) – в открываемом
с помощью этой кнопки меню задается отображение кнопок включения/выключения режимов
черчения в строке состояния (рис. 1.20).

Рис. 1.20. Контекстное меню настройки строки состояния

Clean Screen (Очистка экрана) – очищает экран. При ее нажатии исчезают все панели
инструментов – таким образом увеличивается область графического экрана. Эта функция
полезна при работе на мониторах с небольшой диагональю.
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Палитры

 
Палитры AutoCAD – это отдельные окна, предоставляющие дополнительные функции

(рис. 1.21). По сути, это те же панели инструментов, позволяющие, однако, выполнять более
разнообразные действия и работающие в диалоговом режиме.

Рис. 1.21. Палитра Sheet Set Manager (Менеджер подшивок)

Как и панели, палитры могут быть плавающими и прикрепленными. В плавающем
режиме у палитры появляется заголовок, содержащий название палитры и три кнопки. Верх-
няя кнопка с крестиком служит для закрытия панели. Расположенная далее кнопка со стрел-
ками скрывает/восстанавливает палитру. Эта функция позволяет палитре не занимать лишнее
место и при этом оставаться постоянно доступной. Нижняя кнопка открывает меню (рис. 1.22),
с помощью которого вы можете закрепить палитру у левого или правого края рабочей области,
разрешить/запретить закрепление и скрытие панели. Кроме этих пунктов, могут быть и дру-
гие, характерные для конкретной палитры.
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Рис. 1.22. Меню палитры Sheet Set Manager (Менеджер подшивок)

Чтобы получить доступ к палитрам, выполните команду ленты View → Palettes → Tool
Palettes (Вид → Палитры → Инструментальные палитры).

 
Настройка пользовательского интерфейса

 
Программа AutoCAD предоставляет пользователю широкие возможности адаптации

интерфейса для решения конкретных задач. Управлять настраиваемыми элементами интер-
фейса, к которым относятся рабочее пространство, панели инструментов, меню и сочетания
клавиш, можно с помощью диалогового окна Customize User Interface (Настройка интер-
фейса пользователя) (рис. 1.23). Чтобы его открыть, нажмите кнопку User Interface (Интер-
фейс пользователя) на вкладке Manage (Управление) в группе Customization (Настройка)
ленты или выполните команду меню Tools → Customize → Interface (Сервис → Настройка →
Интерфейс). Вы также можете щелкнуть правой кнопкой мыши на любой панели инструмен-
тов и в контекстном меню выбрать пункт Customize (Настройка).

Рис. 1.23. Диалоговое окно Customize User Interface (Настройка интерфейса пользова-
теля)



А.  А.  Орлов.  «AutoCAD 2010»

34

Окно открывается на вкладке Customize (Настройка), которая содержит четыре области.
• Customizations in All Files (Настройка всех файлов) – здесь представлены элементы

настраиваемого пользовательского интерфейса, в которые можно вносить изменения. Вы
можете изменять все файлы интерфейса или выбрать какой-либо один из раскрывающегося
списка, расположенного в верхней части области (рис. 1.24).

Рис. 1.24. Список файлов настраиваемого пользовательского интерфейса

• Command List (Список команд) – содержит полный перечень команд AutoCAD 2010.
Для упрощения поиска вы можете выбрать в списке категорию, которой принадлежит нужная
вам команда.

• Preview (Предварительный просмотр) – отображает внешний вид выделенного объ-
екта. Здесь же можно изменить вид значка какой-либо команды. Для этого выделите команду в
списке Command List (Список команд) и в области Button Image (Значок кнопки) выберите
один из предложенных значков. Если вы хотите вручную нарисовать значок, нажмите кнопку
Edit (Изменить). На экране отобразится диалоговое окно Button Editor (Редактор кнопок)
(рис. 1.25). Инструменты, предоставляемые редактором, аналогичны возможностям графиче-
ского редактора Paint – стандартного инструмента операционной системы Windows.

Рис. 1.25. Диалоговое окно Button Editor (Редактор кнопок)

• Properties (Свойства) – позволяет изменять свойства выделенных объектов. Например,
вы можете изменить вид кнопки, загрузив собственный графический файл.
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Теперь, ознакомившись с основными элементами диалогового окна, создадим собствен-
ную панель инструментов и добавим на нее кнопки.

1.  В области Customizations in All Files (Настройка всех файлов) найдите пункт
Toolbars (Панели инструментов). Щелкните на нем правой кнопкой мыши и выберите в
появившемся меню пункт New Toolbar (Создать панель инструментов) (рис. 1.26).

Рис. 1.26. Создание новой панели инструментов

2. Введите название панели и определите ее свойства в области Properties (Свойства).
· Раздел General (Общие) позволяет изменить название и описание панели. Для этого

щелкните кнопкой мыши на любом пункте и введите нужное значение в правом столбце.
· В разделе Appearance (Вид) вы можете указать, будет ли панель отображаться по умол-

чанию, задать ее ориентацию, координаты появления и количество строк. Например, чтобы
по умолчанию панель инструментов не отображалась на экране, щелкните на пункте Default
Display (Отображение по умолчанию). Справа появится кнопка со стрелочкой. Щелкните на
ней и в открывшемся списке выберите Do not add to workspases (Не добавлять к рабочим
пространствам).

3. Теперь следует добавить на панель команды. Для этого выберите необходимую команду
в списке и с помощью мыши перетяните ее в область Customizations in All Files (Настройка
всех файлов). Поместите указатель напротив созданной вами панели инструментов (рис. 1.27).
Отпустите кнопку мыши – и команда будет добавлена на эту панель.
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Рис. 1.27. Добавление команды на панель инструментов

4. Нажмите кнопку OK для создания новой панели (рис. 1.28).

Рис. 1.28. Новая панель инструментов
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Установки файлов чертежей

 
Все чертежи, созданные в программе AutoCAD, хранятся в файлах с расширением DWG.

В таком файле содержится полная информация о чертеже: всевозможные стили, параметры,
такие как единицы измерения, режимы черчения и т. д. Формат DWG отличается небольшим
временем сохранения, особенно в случае, если это файлы с большим количеством аннотаци-
онных объектов.

По мере развития программы формат используемых файлов также изменяется, поэтому
чертежи, созданные в более новых версиях AutoCAD, не могут быть открыты в более старых.
С выходом AutoCAD 2010 в формат DWG также были внесены изменения, поэтому чертежи,
по умолчанию сохраненные в AutoCAD 2010, не будут открываться в более ранних версиях.

В предыдущих версиях программы размер единичного объекта на чертеже не мог пре-
вышать 256 Мбайт. В AutoCAD 2010 этот предел был увеличен до как минимум 4 Гбайт (в
зависимости от конфигурации вашей системы).

Для создания нового файла можно применить один из двух способов:
• без использования окна начала работы (это наиболее простой способ, который приме-

няется по умолчанию);
• с заданием различных параметров в окне начала загрузки.

 
Создание нового документа без

использования окна начала работы
 

Для создания нового файла упрощенным способом выполните следующие действия.
1. Щелкните на кнопке New (Новый)

на панели быстрого доступа или выполните команду меню File → New (Файл → Новый).
На экране отобразится диалоговое окно Select template (Выбор шаблона) (рис. 1.29). Это окно
похоже на стандартное окно выбора файлов операционной системы Windows и отображает
содержимое каталога Template (Шаблон), принадлежащего директории, в которую была уста-
новлена программа AutoCAD. В данной папке находятся файлы с расширением DWT, кото-
рые представляют собой готовые шаблоны чертежей, обладающие некоторыми настройками и
использующиеся как основа для создания документов.
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Рис. 1.29. Диалоговое окно Select template (Выбор шаблона)

2. Выделите нужный шаблон. При этом в области Preview (Образец), расположенной в
правой части окна, появится изображение объектов, которые имеются в выбранном шаблоне.

3. Выберите нужный шаблон и нажмите кнопку Open (Открыть).
Примечание
По умолчанию программа AutoCAD не содержит шаблонов,

созданных по российским стандартам черчения, поэтому при
необходимости следует самостоятельно добавить файлы нужных
шаблонов в каталог Template (Шаблон).

Если вы не хотите, чтобы в новом чертеже использовался какой-либо шаблон, нажмите
маленькую кнопку со стрелкой, расположенную справа от кнопки Open (Открыть). В открыв-
шемся меню выберите единицы измерения чертежа (метрические или британские), на основе
которых будет создан новый файл (рис. 1.30). Если выбрать в меню пункт Open (Открыть),
файл будет создан на основе выделенного в данный момент шаблона.

Рис. 1.30. Создание чертежа без шаблона
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Создание нового документа с помощью окна начала работы

 
Чтобы при создании нового файла использовалось окно начала работы, необходимо при-

своить значение 1 системной переменной STARTUP. Для этого выполните следующие дей-
ствия.

1. Введите в командную строку название переменной и нажмите клавишу Enter или Про-
бел. Появится запрос:

Enter new value for STARTUP <0>:

2. Введите 1 и снова нажмите клавишу Enter или Пробел.
3. Щелкните на кнопке New (Новый) на панели быстрого доступа или выполните команду

меню File → New (Файл → Новый). На экране появится диалоговое окно Create New Drawing
(Создание нового чертежа) (рис. 1.31).

Рис. 1.31. Диалоговое окно Create New Drawing (Создание нового чертежа)

Рассмотрим основные элементы этого окна.
• Заметьте, первая кнопка – Open a Drawing (Открытие чертежа) – неактивна.
Выйдите из программы AutoCAD и снова запустите ее. Теперь при щелчке на кнопке

New (Новый) на панели быстрого доступа или при выполнении команды File → New (Файл →
Новый) будет открываться окно Startup (Запуск), в котором кнопка Open a Drawing (Откры-
тие чертежа) будет активна (рис. 1.32). При нажатии кнопки внутри окна отобразится область
Select a File (Выбор файла), позволяющая выбрать созданный ранее файл и открыть его. Если
нужный файл отсутствует в данной области, вы можете нажать кнопку Browse (Обзор) и в
открывшемся окне Select File (Выбор файла) найти необходимый документ. Это окно очень
похоже на Select template (Выбор шаблона), описанное выше.
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Рис. 1.32. Открытие чертежа

• Вторая кнопка – Start from Scratch (Простейший шаблон) (нажата на рис. 1.31). С ее
помощью создается чертеж, не отличающийся от чертежа, созданного первым способом (без
использования окна начала работы) без выбора шаблона.

• Следующая кнопка – Use a Template (Использовать шаблон). Создание чертежа иден-
тично созданию нового файла без использования окна Startup (Запуск). Вы можете выбрать
шаблон документа из имеющихся или отказаться от шаблонов. При нажатии кнопки Browse
(Обзор) откроется диалоговое окно Select a template file (Выбор файла шаблона).

• Последняя кнопка – Use a Wizard (Использовать мастер). Она вызывает мастер созда-
ния чертежа, с помощью которого вы сами можете настроить параметры нового документа.
Мастер может работать в двух режимах: Advanced Setup (Детальная подготовка) и Quick
Setup (Быстрая подготовка). При выборе первого способа настраивается большее количество
параметров.

Создадим новый чертеж с помощью мастера детальной подготовки.
1. В окне Startup (Запуск) нажмем кнопку Use a Wizard (Использовать мастер), в обла-

сти Select a Wizard (Выбрать мастер) выделим пункт Advanced Setup (Детальная подготовка)
и нажмем кнопку OK (рис. 1.33).
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Рис. 1.33. Вызов мастера создания нового чертежа

2. В первом окне мастера (рис. 1.34) предлагается выбрать единицы измерения чертежа,
а также, в раскрывающемся списке, точность значений (количество знаков после запятой).
Настроив параметры, нажимаем кнопку Далее.

Рис. 1.34. Выбор единиц измерения
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3. Следующее окно позволяет выбрать единицы измерения углов, а также их точность.
Снова вводим свои значения и нажимаем кнопку Далее.

4. Затем указываем направление нулевого угла. Вы можете выбрать East (Восток), North
(Север), West (Запад), South (Юг) или указать произвольное значение (отсчет при этом будет
происходить от направления East (Восток)). Устанавливаем нужные значения и нажимаем
кнопку Далее.

5. После этого необходимо задать направление отсчета углов: против часовой стрелки
или в ее направлении. Делаем свой выбор и нажимаем кнопку Далее.

6. В последнем окне вы можете установить размер области, доступной для рисования.
Вводим соответствующие параметры и нажимаем кнопку Готово. Чертеж создан.

 
Сохранение и завершение работы

 
Для сохранения документа нажмите кнопку Save (Сохранить) на панели быстрого

доступа либо на панели инструментов Standard (Стандартная). Можно также выполнить
команду меню File → Save (Файл → Сохранить). На экране появится диалоговое окно Save
Drawing As (Сохранить чертеж как) (рис. 1.35).

Рис. 1.35. Окно сохранения чертежа

В нем вы можете выбрать каталог для сохранения, название файла, а также его тип: DWG
или DXF (тип файлов, который можно открыть в других приложениях, а не только в AutoCAD).
При этом вы можете указать версию формата, то есть, например, сохранить чертеж в формате,
совместимом с ранними версиями программы.

Если вы хотите сохранить файл под другим названием, щелкните на кнопке меню с бук-
вой «А» в левом верхнем углу окна программы и выполните команду Save As → AutoCAD
Drawing
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